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List of Abbreviations 
Abbreviation Term/Phrase/Name 

ACS American Community Survey 
ADT Average Daily Traffic. The amount of 

vehicular traffic that crosses an imaginary line 
across a roadway in a 24-hour period. ADT 
information typically includes both directions 
of vehicle travel (if on a two-way street).  

AM Peak Refers to the morning weekday peak traffic 
period, which includes primarily work and 
school trips. 

AOC Auto Occupancy 
ASN Assignment 
CDOT Colorado Department of Transportation 
DIR Direction 
DOT Department of Transportation 
EE External to External 
EI External to Internal 
FAC-Type Facility Type 
GammaParams Gamma Parameters 
GHG Green House Gas 
GIS Geographic Information Systems 
GUI Graphical User Interface 
HBO Home Based Other 
HBSE Home Based School Elementary 
HBSH Home Based School High School 
HBSS Home Based School Secondary 
HBSU Home Based School University 
HBW Home Based Work 
HBWIE Home Based Work Internal-External 
INC Income 
MOVES Motor Vehicle Emission Simulator 
MUT Flow Multi-Unit Truck Flow (Large Trucks) 
N North 
NHBO Non-Home Base Other 
NHBW Non-Home Base Work 
NoCCs No Centroid Connectors 
OD Origin-Destination 
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Off Peak Refers to the non-peak weekday traffic 
period, excluding morning and afternoon 
peak traffic periods. 

PACOG Pueblo Area Council of Governments 
PM Peak Refers to the afternoon weekday peak traffic 

period, including primarily work trips. 
POP Population 
PPM Pueblo Planning Model 
S South 
SE Socioeconomic 
SH State Highway 
SPData Socioeconomic and Population Data 
SPDCAP Speed and Capacity 
SPGen Special Generator 
SUT Flow Single Unit Truck Flow (Medium Trucks) 
TAZ Traffic Analysis Zone 
TD Trip Distribution 
TG Trip Generation 
ToD Time of Day 
TotEmp Total Employment 
TransCAD Refers to the software platform used for the 

PACOG travel demand model. 
VoC Volume to Capacity 
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1     Introduction 
The Pueblo Planning Model (PPM) went through its second comprehensive update in 
2024. This update of the model, referenced as PPM3, served multiple purposes: 

1. To refresh all the travel demand model files with updated 2020 base year data 
using the now available 2020 U.S. Census, American Community Survey data 
files, and Colorado DOT information 

2. To update the long-range planning horizon year from 2045 to 2050  
3. To build the first 4-step model for PACOG integrating a mode choice module and 

transit network 
4. To build in a Greenhouse Gas (GHG) component for both scenario testing and a 

built-in means of producing MOVES-ready output from each model run 
5. To update the model from Caliper Corporation’s TransCAD Version 8.0 to 9.0 

This document will guide the user in setting up and running the enhanced 2024 PACOG 
model. Details regarding the default directory structure, required files, running the 
model, preparing, and understanding model output are described in detail in the 
subsequent sections. Details of the model update from a methodological standpoint are 
provided in a companion report “PACOG Travel Model Methodology, 2024.” 

2  Setting Up and Opening the PACOG Model 

2.1 System Requirements 
The model was built in TransCAD 9 Build 32945 and should be run only in TransCAD 9. 
While the model may run in previous versions of TransCAD, there is no guarantee that 
the results will be correct or that the model will run to completion. To verify any 
TransCAD version, look at the About tab in the model GUI. The version the model was 
built in and the version the model is opened in are documented in this GUI tab.  

System Requirements 
Operating System Windows 7 or later 

Processor Intel Core i5 or later (i7, i9, or Xenon recommended) 
Memory 4GB – 12 GB 
TransCAD Software Version 9.0 Build 32945 or later is recommended. 
Disk Space (Installation and Input) 10 MB (code and reference scenario) 
Disk Space (Each scenario) 150 MB for each scenario 
Software Type MS Office and TransCAD must either be 32-bit or both be 64-bit. 
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2.2 Installing the PPM Model 
The Pueblo Planning Model (PPM) will be delivered as a zip file named PPM. You will 
need to first extract the zip file to a user specified location anywhere on the computer 
that will be used to run the model. The zip file can be extracted using 7-zip software 
available from www.7-zip.org. Then, to set up the full PPM directory, copy the full 
extracted PPM folder to a user-specified location anywhere on the computer that will be 
used to run the model.  
C:\PPM was used in examples included in this User Guide. Although the directory does 
not need to be in the root directory of the computer C drive, it is recommended that the 
model be installed on a local hard drive rather than a network drive. This is because the 
use of a network drive will significantly improve model performance and processing 
speeds. Additionally, the PPM model should not be installed in a location that is actively 
synchronized, such as Dropbox or OneDrive, because these tools will interfere with 
TransCAD’s ability to iteratively read and modify files. 
Review the PPM installation to be sure it is complete. The installed PPM folder contains 
all model components. The code folder holds the compiled code and logos. The 
scenarios folder holds the inputs and outputs for each scenario created. The model will 
be delivered with the reference scenario and base scenarios for 2020, 2030, 2040 and 
2050. Confirm that the PPM folder directory structure as copied to your computer is 
structured as shown below. 
 
   

PPM Root and Scenario (base_2000) File Directories  

  

http://www.7-zip.org/
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2.3  Opening TransCAD  
Open the TransCAD application installed on your computer by clicking on the startup 
menu listing or the desktop or startup shortcut. If you have not opted out of Quick Start 
for your TransCAD install, a dialog box as shown below will open. Select None (1), 
followed by OK (2). 

 
TransCAD Startup Action Dialog Box 
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2.4 Installing the PPM Model Add-In 

2.4.1 Opening TransCAD Add-In Setup Menu 
With the TransCAD software open, the next step is to create the TransCAD PPM Add-
In. To set up the Add-In open up TransCAD and navigate to the Tools menu (1). Once 
the Tools menu is open select GIS Developer’s Kit (2), followed by Setup Add-Ins (3) as 
shown below. Setup Add-Ins will open a dialog box that will be used to create the Add-
In for the Pueblo Planning Model (PPM). 

Add-In Setup Process 

2.4.2 Filling the TransCAD Add-In Dialog Box 
Use the steps listed below and shown in the screenshot on the following page, to fill in 
the Setup Add-Ins dialog box.  

1) Select/Click Add. 
2) Select/Click Dialog Box. 
3) Fill Description with Pueblo Planning Model. 
4) Fill Name with PPM. 
5) Browse to and Select UI Database ppm.dbd. 
6) Select/Click OK. 

 
  

  

1 

2 
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The Description can be named anything but for consistency it is named “Pueblo 
Planning Model” (PPM). Note that the Name must be “PPM.” This name setting is what 
calls the code and must be exactly as shown; this input is case sensitive. 

Setup Add-Ins Dialog Box 
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2.5 Opening the PPM Model 

2.5.1 Opening the PPM Model 
To open the PACOG Model, from the Tools pull-down menu select GIS Developer’s Kit 
> Add-Ins > Pueblo Planning Model as shown below. 

Add-In Pull-down Menu 

2.5.2 Selecting the PPM Base Folder 
Opening the Pueblo Planning Model Add-In will then prompt the user to select the base folder 
as shown below. The folder it is looking for is the PPM folder. For this example, the PPM 
folder is in C:/PPM. Note that choosing any other folder will result in the GUI not opening 
correctly. A clear sign that the wrong folder was chosen is a black box at the top of the GUI 
instead of the PACOG logo. To remedy this just close the model and open it again this time 
making sure to choose the correct PPM folder location. After selecting the correct base folder, 
the Model GUI will open.  

 
PPM Root Directory Prompt 
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3 PACOG Model Structure  
3.1 Directory Structure 
As noted in the installation instructions, the PPM does not require a specific root 
directory location. The model package can be set up in any directory. However, 
following the default structure will reduce the need to revise file paths. Below the root 
directory files are organized in two folders (code and scenarios). Inside the code folder 
the compiled code that will be used to set up the Add-In for TransCAD 9 can be found. 
The directory structure shown below is set up on the C: drive inside a folder called PPM.  

 
PPM Main Folder Structure  

3.2 Reference Scenario  
The scenarios folder contains the reference scenario folder, four base folders (for 
2020, 2030, 2040 and 2050) and will contain all model scenarios created by the user. 
The reference scenario folder contains all the input files and parameter files needed to 
run both the 2020 and the 2050 base models. Each time a new scenario is created the 
reference scenario “inputs” folders and contents are copied and renamed with the 
name of the new scenario. 
  

 
Reference Scenario Folder Structure 
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Reference Scenario Inputs Folder Content 
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Scenario Builder Outputs Folder Directory 

3.3 Required Files 
All the base year files required to run the model are provided with the model setup. The 
base year can be run with no modifications to the files if the directory structure is the 
same as described in the Directory Structure section. To run the future year scenarios, 
most of the required files will remain unchanged. A list of the files is provided below. 

Required PPM Model Input Files 
File Name File Extension File Type 
2020_BaseNetwork .dbd TransCAD 
Routes_2020 ,dbd TransCAD 
TAZ_Final .dbd TransCAD 
SEData_2020 .bin TransCAD 
ParametersList .bin TransCAD 
Production_Rates .bin TransCAD 
Attraction_Rates .bin TransCAD 
SPGEN2020 .bin TransCAD 
HBWIE_2020 .bin TransCAD 
SPDCAP .bin TransCAD 
GammaParams .bin TransCAD 
VOC .bin TransCAD 
EI_IE_Targets_2020 .bin TransCAD 
EE_2020 .mtx TransCAD 
TOD .bin TransCAD 
PPM_MCv3  .mdl TransCAD 

 
Each of the required input files is described below.  
• 2020_BaseNetwork – TransCAD highway/streets network line layer. 
• Routes_2020 – TransCAD Transit routes system network line layer. 
• TAZ_Final – 227 internal zones plus 8 external zones. 
• SEData_2020 – 2020 population and employment data. 
• ParametersList – List of all parameter files. Used as an input to the scenario builder 

tab in the model GUI. 
• Production_Rates – Calibrated trip generation rates for productions. 
• Attraction_Rates – Calibrated trip generation rates for attractions. 
• SPGEN2020 – Zones with special generators. 
• HBWIE_2020 – The number of HBWIE trips to be removed to avoid double count. 
• SPDCAP – Speed and capacity by functional class and area type lookup table. 
• GammaParams – Trip distribution gravity model gamma parameters. 
• VOC – Auto occupancy shares used to convert person trips into vehicle trips. 
• EI_IE_Targets_2020 – Internal to External and External to Internal trip targets used 

to calculate these trips. 
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• EE_2020 – External to external trips to be added into the trip tables. 
• ToD – Time of Day factors to be applied before the trips are assigned. 
• PPM_MCv3 – Mode choice model that replaces the earlier mode split approach.  

3.4 Scenario Input Files 
The input files are all files that are needed to run the model. To run the 2020, 2030, 2040 
or 2050 base scenarios, these inputs should not be modified. However, these files can 
be updated to create user-specified alternative scenarios by using the Scenario Builder. 
As an example, inputs for the 2020 base year scenario are described here. 

3.4.1 Highway Network Line Layer - Line Work 
The Highway Network Line Layer for the 2020 base year scenario is named 
2020_BaseNetwork. This file is read when creating the *.net file and used as the base 
to which modeled traffic flows are assigned. The network is also used to create the 
loaded network by joining assignment results to the network. Loaded networks can be 
found in outputs folders. 

 

PPM Model 2020 Base Year Highway Network – Full Extents 
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3.4.2 Highway Network Line Layer – Base Attribute Table 
The insert view of the Highway Network Line Layer for the 2020 base year scenario, as 
shown below, presents the Dataview attributes from the line layer for Pueblo Boulevard 
for the segment posted with an “i” (information). Some attributes are coded by the 
users and others are calculated based on look-up tables incorporated in the model code 
or are calculated based on user input. 
 

PPM Model 2020 Base Year Highway Network – Zoom 
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3.4.3 Transit Routes Line Layer 
The Routes Line Layer for the 2020 base year scenario is named Routes_2020. The 
insert view of the Routes Line Layer shown below presents the Dataview attributes from 
the line layer for the Irving Place Route (Route #3) posted with an “i” (information). 
Data for all 22 of the 2020 base year routes is shown on the following page. 

 
PPM Model 2020 Base Year Transit Routes - Zoom 
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2020 Base Year Routes Dataview Information (i) 

3.4.4 TAZ Layer  
TAZ Geography - PPM Model includes 385 internal and 8 external zones as shown. 

 
PPM Model Traffic Analysis Zones System 
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TAZ Attributes - TAZ-level population and employment data used for the trip 
generation step of the PACOG Model are provided separately in a TransCAD binary file. 
For the 2020 base year scenario this file is named SEData_2020. Socioeconomic 
attribution of the population and employment totals by category comprise this PACOG 
Model input with values for these attributes varying by scenario year (e.g., 2020, 2030, 
2040, 2050). A portion of the SEData_2020 file for the PACOG Model is shown below. 

 
PACOG 2020 Socioeconomic Data  
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3.5 Parameter Files 
The parameters files consist of inputs that were calibrated and are not to be modified 
for any model runs. When running the 2050 future year model run these parameter 
files are part of the model installation as part of the reference scenario. These files will 
be included in all user created scenarios.  

3.5.1 ParametersList Parameter File  
The ParamtersList parameter file all parameter files used as basic input to PACOG 
Model scenarios. The full ParametersList parameter file is presented below.  

 
ParametersList Parameter File  

3.5.2 Production_Rates Parameter File 
Production rates are the estimated cross-classified trip generation rates used by the 
model to calculate trip production trip ends for household size/income categories. The 
Production_Rates parameter file is presented below.  

 
Production_Rates Parameter File 
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3.5.3 Attraction_Rates Parameter File 
Attraction rates are the estimated cross-classified trip generation rates used by the 
model to calculate trip ends for trip attractions by trip purpose for cross classified 
household size/income categories. These trip attraction rates comprise the 
Attraction_Rates parameter file presented below. 

 
Attraction_Rates Parameter File 

3.5.4 SPGEN2020 Parameter File 
Trip end productions and attractions for special generator zones by trip purpose and 
vehicle class comprise the SPDGEN2020 parameter file. The special generator zones 
receive focused treatment in the travel model. Trip ends for these zones for the 2020 
base year scenario are presented below. Special generator production and attraction 
trip ends for these zones vary by scenario year (e.g., 2020, 2030, 2040, 2050). 

 
SPGEN2020 Parameter File 
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3.5.5 HBWIE_2020 Parameter File 
The HBWIE_2020 parameter file includes a single value that represents the number of  
Home-Based Work trips traveling outside of Pueblo County (HBWIE) for the 2020 base 
year model scenario. This number is removed from calculated (through trip generation 
rates) Home-Based Works trips to ensure that these trips are not double counted. This 
parameter file, shown below of the 2020 base year, varies by scenario year (e.g., 2020, 
2030, 2040, 2050) and thus is unique for each scenario year. 

 
HBWIE_2020 Parameter File 

3.5.6 Gamma_Params Parameter File 
Trip distribution gravity model gamma parameters by purpose comprise the 
GammaParams tabular parameter file as shown below. The included values are 
calibrated and should not be modified. These parameters are the same for all 
scenarios. 

 
Gamma_Params Distribution Gamma Parameter File 
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3.5.7 SPCAP Lookup Table Parameter File 
The values in the SPCAP lookup table parameter file ae used to fill highway network 
speed and capacity attributes based on functional class and area type as shown below. 
These parameters are the same for each scenario year, including for the base year 
calibration scenario. 

 
PACOG Model Speed/Capacity Link Lookup Table 
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3.5.8 VOC Vehicle Occupancy Lookup Table Parameter File 
Vehicle occupancy rates, as shown below, are used by the PACOG Model to convert 
person trips into vehicle trips by purpose for highway assignment for those trips not 
input to mode choice.  These trips are comprised of non-home-based trips. These 
parameters are the same for each scenario year, including for the base year scenario. 

 
VOC Vehicle Occupancy Table Parameter File 

3.5.9 EI_IE_Targets_2020 Parameter File 
The EI_IE_Targets_2020 parameter file includes External to Internal and Internal to 
External trip targets for auto, medium truck, and heavy truck categories for the 2020 
base year scenario. These targets vary by scenario year (e.g., 2020, 2030, 2040, 2050) 
and thus are unique for each scenario year.  

 
EI_IE_Targets_2020 
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3.5.10 EE_2020_Parameter File 
The EE_2020 parameter file is a matrix that includes External to External trips to be 
added into the trip tables for auto, medium truck, and heavy truck categories for the 
2020 base year scenario. These targets vary by scenario year (e.g., 2020, 2030, 2040, 
2050) and thus are unique for each scenario year. 

EE_2020 External-External Trips Parameter File 

3.5.11 ToD Time-of-Day Lookup Table Parameters File 
The ToD lookup table parameter file includes Time-of-Day factors to be applied before 
the trips are assigned. These factors are shown below for AM Peak (one-hour), PM 
Peak (one-hour) and Off-Peak (22-hour) time periods. These parameters are the same 
for each scenario year, including for the base year calibration scenario. 

 
ToD Time-of-Day Lookup Table Parameters File 
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4  Overview of the PPM Model GUI 
The Graphic User Interface (GUI) of the Pueblo Planning Model has three main  active 
tabs: Scenario Builder, Run Model/GHG, Maps and Reports as well as an 
informational tab: About. Each tab is described in detail in the following sections. Of 
note is the option shown called “GHG Analysis.”  This option allows the user to evaluate 
Greenhouse Gas scenarios as part of the modeling process. Selecting this option will 
open a GHG subtab that allows the user to evaluate GHG mitigation strategies for the 
model run defined by the user in the Run Model tab.  

4.1 Scenario Builder Tab 
The scenario builder tab allows the user to create new scenarios, and to edit scenario 
inputs for alternatives analysis. This tab is on top when the model first opens. An 
overview of the options available for building a new scenario is presented below. 
Section 5 details how to create a new scenario or edit existing scenario inputs using the 
Scenario Builder. 

 
Scenario Builder Tab Overview 

Create New 
Scenario 

 Edit Scenario 
Inputs 

 Edit Network 
Layer 

 Edit 
Parameters 

Open TAZ 
Layer 
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4.2 Run Model Tab 

4.2.1 Base Run Model Tab  
The Run Model tab will run the model for any scenario that is selected. It also has 
buttons to run each piece of the model individually, and to run the model with and 
without the feedback loop. Running the Model requires the scenario, the network line 
layer and the transit routes layer to be selected, as shown below.  

The first thing that must be done to run the model is to select which scenario to run. 
Select the scenario from the drop-down menu in the Select Scenario section (1). All 
available scenarios will be listed, and any can be chosen. Once the scenario is selected 
the highway network layer (2) and transit routes layer (3) must be chosen. Finally, the 
run option (stepwise, with feedback or without feedback) is selected by clicking on the 
chosen radio button. In this example the 2030_base scenario was run with the Run All 
w Feedback (4) option and GHG Analysis was not implemented. 

 
Run Model Tab Overview 

 Select Run 
Scenario 

 Select Run 
Scenario 

Option to Run 
Stepwise 

 Select Transit 
Routes Layer 

Option to Run 
with Feedback 

 Select Run 
Options 

 Option to Run 
GHG Analysis 

 Select Highway 
Network Layer 

1 

1 

4 

2 
3 
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4.2.3 Running a Model Scenario with GHG Analysis 
Details on the development of the work from home (WFH) percentages by income category 
are available in the Methodology Report. The base year conditions were identified as 1% 
WFH for income level 1, 3% WFH for income level 2, 6% WFH for income level 3, and 11% 
WFH for income level 4. This baseline was estimated from the 2019 and 2021 U.S. Census 
American Community Survey journey to work data. Home to work trips for these four 
groups have been removed from the model trip tables.  

Model runs can be quickly created for alternative WFH, transit frequency, and transit 
running speed scenarios. This is done by implementing alteration of these base year 
condition from the GHG subtab, followed by a model run with the GHG Analysis radio 
button checked. First setup your model run in the Run Model tab and check GHG Analysis 
(6). This will open the GHG subtab in which GHG mitigation to be tested can be selected. 
For this example, WFH is increased in the GHG tab to 10% (1) and 20% (2) for the HBW3 
and HBW4 household income categories. Once the GHG strategies have been selected, 
the user must return to the Run Model tab to complete the model run. In the example the  
Run All with Feedback (7) option selected with GHG Analysis radio button checked (6). 

  

Model Run with GHG Analysis  
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4.3 Maps and Reports Tab 
The Maps and Reports Tab provides the user with TAZ maps, link maps, and model 
reports for mode choice, trip length, and transit boardings. It also includes a box to view 
and generate links level output ready for input to CDOT-approved GHG programs. For 
base year 2020 validation checking, a set of reports on highway traffic by volume class, 
facility type, screenline, and all counted records is also provided. Running the maps 
requires the scenario (1) and the desired map or report (2) to be selected as shown 
below. Next the selected maps or reports are run (3) and opened (4). 
The user can choose from a set of maps at the zonal level or at the network level. Note 
also that the output is available for each of the three time periods in the model: AM 
Peak (7:30 -8:30 am), PM Peak (4:30 - 5:30 pm) and Off-Peak. These three time 
periods are summed to produce daily modeled traffic which is also provided. The 
PACOG model GUI will name the standard reports using the scenario name selected in 
the Scenario builder tab. As an example, if a scenario is named base_2020 its reports 
will be named with the same prefix. Each scenario has its own folder with a uniform set 
of input and output folders allowing the user to keep track of multiple runs.  

 
Maps and Reports Tab 

Select TAZ Map 
Options Network 

 

 Select 
Scenario 

Choose 
Network Option 

 

 Select Transit 
Routes Layer 

Choose Other 
Output Options 

 Select Transit 
Routes Layer 
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4.4 About Tab  
The About Tab is basic. It contains the developer information and TransCAD versioning 
information. The Model was built using TransCAD 9 Build 32945.Using this version 
and build, or a more recent Build version of TransCAD 9 should prevent any unforeseen 
TransCAD software issues. The About Tab of the GUI reports the version and build in 
which the Model has been opened. 

 
About Tab 
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5 Creating and Editing a New Scenario 

5.1  Creating a New Scenario 
As presented below, to create a new scenario, Select the Scenario Year (1) from the 
drop-down menu. Next Enter the Scenario Name (2) for the new scenario. The year 
will be appended to the scenario name, so it does not need to be included in the name 
for the new scenario. Once a year and the name are entered, click on the Create (3) 
radio button. A command prompt will appear and the files from the reference scenario 
will be copied into the newly created folder. If an intermediate year is created, all 
parameter files will be interpolated to match the expected growth for that year. See the 
methodology report for more details on the interpolation process.  

  

Creating New Scenario 
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5.2 Creating a New Highway Network Layer 
Once a scenario has been created, input files for the new scenario can be modified. The 
Edit Existing Scenario Inputs section will allow editing the of the highway network line 
layer and opening both the TAZ file and the parameters files. Any edits made to the 
Scenario Inputs will only modify those files in the selected scenario. If an edit is made 
by mistake the scenario can be recreated or the file can be copied to the new scenario 
from the reference scenario. 

To set up the new scenario for edits, it is useful to create a new, scenario-specific 
highway network. In the Edit Existing Scenario Inputs/Select Scenario section, first 
select the new scenario (1) using the pull-down menu. Then enter the New Name (2) for 
the network and finally, click the Create (3) radio button. The new network layer should 
be used for all network editing for the New Scenario.  

 
Create New Highway Network Line Layer  

1 

2 3 
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5.3 Connecting Highway Network and Routes Layers 
Before running the model for the new scenario, including the new /edited network, a 
routes layer must be connected to the new highway network line layer. To do this, with 
the new highway network line layer open, the Move function from the Route Systems 
Utilities tool must be used to connect the routes layer from the base scenario to the new 
highway network layer. To do this, first open the Route Systems pull-down menu. Next 
select Utilities and then select Move. After selecting Move (1), a file directory menu will 
pop up; confirm that it is the correct file directory for the inputs\GIS folder for your new 
scenario and click on the Open radio button (2). 

 
Move Routes Line Layer to Highway Network Line Layer (1,2)  

1 
1 

2 
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A second dialog box will then pop up showing the Route System to be connected to the 
new Highway Network as well as the basis for the new Highway Network (2020_base 
Network). Click on the OK (3) radio button. 

 
Move Routes System to New Highway Line Layer (3) 
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To confirm that the correct highway network line layer and transit routes line layer are 
now connected, first close the new highway network line layer. Next use File>Open 
from the TransCAD main menu to browse within the new scenario folder to find and 
open the routes line layer file (go to C:\PPM\new scenario name\inputs\GIS). Click on 
the routes line layer file to open the file. In this example that will be Routes_2020. Then 
use the TransCAD main menu multilayer tool (stacked sheets icon) to confirm that the 
correct highway network layer, EditedNetwork.DBD, and transit line file layer, 
Routes_2020.DBD, are now connected. First, click on the Highway/Streets layer (4) 
and read the Geographic File path at the bottom of the dialog box. Then click on the 
Route System layer (5) and read the Geographic File path at the bottom of the dialog 
box. The paths for both files should begin with the following path: C\PPM\ new scenario 
name\inputs\GIS. 

 
Confirm Routes and Highway Network Layers  
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Finally, verify that the transit routes system, Routes_2020.DBD, as connected to the 
highway network, EditedNetwork.DBD, is valid. To do this, select Verify from the 
Routes Systems pull-down menu (6). This will bring up a dialog box showing the 
Connectivity (for all routes), Links Direction, and Route Stops are verified for all 22 
routes included in the 2020 base year routes system. Note that the 2030 base scenario 
routes system included 24 routes and could also have been used for the new 2027 
scenario. Click the OK radio button (7). This will bring up a second dialog box 
sonfirming that the Route System is valid. Click the OK radio button. 

 
Verify Connected Routes Layer File 
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6 Creating/Editing Auto-Generated Maps and Reports  

6.1 Creating/Editing Auto-Generated Maps 
The Maps and Reports tab facilitates the creation of a variety of maps and reports using 
automatic formatting. The automatic map/report formatting uses the abbreviated 
attribute names from model coding in the legends as well as fixed color schemes that 
you may want to modify for clarity. Both legends and color schemes can be easily 
modified to match a report color scheme and clarify contents.  

6.1.1 Creating/Editing a TAZ Total Employment Density Map 
To create the auto-generated Total Employment Density TAZ map, first run and open 
a TAZ Map of Total Employment Density as shown below. To do this, first select the 
scenario (1); then choose the map (2) and then click on the Run Selected Maps or 
Reports radio button (3). After Step 3 has run, click on the Open Selected Maps or 
Reports radio button (4). This will run and open the TAZ map for the selected scenario.  

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Total Employment Density Map Run/Open 
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The auto formatted version of the resulting Total Employment Density TAZ map is 
shown below. After you have run this report, it can also be found in the Outputs > 
Reports > TAZ MAPS folder for the selected scenario. 

To edit the automatically created legend, right click on the Legend. Then click on the 
Properties option (1) in the pop-up menu. This will open the Legend Settings Dialog 
Box. From the Dialog Box edit the default legend implementing options form the 
General, Contents and Fonts tab options (2). From the General tab (3), you can add a 
title, remove, or reformat the scale bar, or set the legend to be a separate image to be 
repositioned on the map.  

 
Editing the Map Legend Using Legend Properties 
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From the Contents tab (4), you can manage legend content, hiding or showing titles or 
elements and/or renaming them.  

 
Contents Tab Map Legend Edits 
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From the Fonts tab (5), you can change font size and font style for legend elements.  

 
Fonts Tab Map Legend Edits  

5 



 

36 
 

To edit the thematic map color scheme or more efficiently edit legend text, go to the 
TransCAD main menu, and use the pull-down menu for the thematic mapping options. 

  

In this example, text for the legend classes is modified and the classes are reset and 
recolored. Using the Color Theme thematic mapping toolbar (circled above) applied to 
the auto-generated map (open) will allow you to efficiently adjust the ranges for mapped 
categories, change legend text and change the color palette used as shown below. 

 
Customized Employment Density Thematic Map 
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6.1.2 Creating/Retrieving a PM Peak Volume/Capacity Bandwidths Link Map 
Auto-generated Link Map options are also available. To create an auto-generated 
Volume/Capacity Bandwidths Link Map, first select a scenario (1), a Network Option 
(with/without centroid connectors) (2) and a Link Map option (3). Next click on the Run 
Selected Maps or Reports radio button (4). After Step 3 has run, click on the Open 
Selected Maps or Reports radio button (5). This will run and open the selected Link 
Map(s) for the selected scenario. In this example the PM peak hour option is selected, 
but multiple maps could be created in a single run for all time-of-day periods.  
The resulting Volume/Capacity Bandwidths Link Map for the PM peak hour condition is 
shown on the following page.  

 

Volume/Capacity Bandwidths Map Run/Open 
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Volume/Capacity Bandwidth Map 

6.2 Creating/Retrieving Auto-Generated Reports 

6.2.1 Creating/Retrieving an Auto-Generated Mode Shares Report 
To create and retrieve an auto-generated Mode Shares report, first select the scenario 
(1), choose the Mode Shares report from the Other Outputs list (2), and then click on 
the Run Selected Maps or Reports radio button (3). After Step 3 has run, click on the 
Open Selected Maps or Reports radio button (4), as shown on the following page.  
This process will run and open the Mode Shares Report for the selected scenario as 
shown on the following page. After you have run this report, it can also be found in the 
Outputs > Reports > Statistics folder for the selected scenario. 
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          Transit Mode Shares Report Run/Open 

 
Transit Mode Shares Report 
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6.2.2 Creating/Retrieving Model Validation Statistics Reports 
To create and retrieve an auto-generated Model Validation Reports, first select the 
base_2020 scenario (1), choose the desired statistics (e.g., Facility Type Statistics) (2). 
Then click on the Run Selected Maps or Reports radio button (3) and click on the 
Open Selected Maps or Reports radio button (4), as shown below. This report can 
also be found in the Outputs > Reports > Statistics folder for the selected scenario. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Model Validation by Facility Type Report Run/Open 

 
Model Validation by Facility Type Report  
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6.2.3 Creating/Retrieving GHG Modeling Transportation Datasets 
To create and retrieve GHG Link Data for input into MOVES4, first select a scenario (1), 
choose GHG Link Data (2) and then click on the Run Selected Maps or Reports radio 
button (3); then click on the Open Selected Maps or Reports radio button (4). This 
report can also be found in the selected scenario Outputs > Reports > Statistics folder.  
The first 52 (of 11,379) GHG link data records for the 2020 base year scenario, sorted by 
link ID, are shown on the following page. Note that both a TransCAD binary file (*.bin) and 
a comma separated file (*.cvs) are output. 

GHG Link Data Run/Open 
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Partial GHG Link Data Table Run/Open – Input to MOVES4 Modeling 
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6.2.4 Creating/Retrieving Automatically Generated GIS Files 
Of note to model users is the automatically generated highway network output in 
TransCAD GIDS format. Known as a “loaded network” this file contains attributes for 
traffic as well as volume to capacity ratios for the three time periods, 2020 count 
information and daily vehicle miles traveled.  The user navigates to the outputs folder 
“GIS” and, for 2020, will find a TransCAD file called “LoadedDailyNetwork_2020.DBD”.  
This file is available with or without centroid connectors for ease of analysis. Key 
attributes from the loaded network can be found in the table below. 

Selected Loaded Highway Network Attributes 
Attribute Name Description 
AB_Daily_Count 2020 Directional Daily Traffic Count 
BA_Daily_Count 2020 Directional Daily Traffic Count 
TwoWay_Count 2020 Two Way Daily Traffic Count 
AB_AM_Flow Directional One Hour AM Traffic 
BA_AM_Flow Directional One Hour AM Traffic 
AB_OP_Flow Directional 22 Hour Off Peak Traffic 
BA_OP_Flow Directional 22 Hour Off Peak Traffic 
AB_PM_Flow Directional One Hour PM Traffic 
BA_PM_Flow Directional One Hour PM Traffic 
AB_Daily_Flow Directional Daily Traffic 
BA_Daily_Flow Directional Daily Traffic 
TwoWay_Daily Two Way Daily Traffic 
VMT_Daily Daily Vehicle Miles Traveled 
AB_AM_VC Directional AM Volume/Capacity Ratio 
BA_AM_VC Directional AM Volume/Capacity Ratio 
AB_OP_VC Directional Off-peak Volume/Capacity Ratio 
BA_OP_VC Directional Off-peak Volume/Capacity Ratio 
AB_PM_VC Directional PM Volume/Capacity Ratio 
BA_PM_VC Directional PM Volume/Capacity Ratio 
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6.2.5 Retrieving Other Model Output 
Additional useful information, some preprocessed and some not, can be found in the 
outputs folders, as shown below. Caliper TransCAD error message, warnings, and run 
statistics reports can be found in the root reports subfolder.  
 

 
Outputs Folder Directory Structure 

Of note is the fact that the reports folder contains four subfolders: JPEGS, Link_Maps, 
Statistics, and TAZ_Maps.  These subfolders are empty until the user generates the 
automated map/report of interest.  The maps and reports can be safely written over 
without error.  The usefulness of the PACOG model can be seen by review and 
understanding of the automated maps and reports.  These maps and reports can also 
be exported to a GIS program or a spreadsheet for further analysis and mapping. 
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